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Q1. What are the four fundament parts of computer? Explain it with the help of diagram. 

Ans.            

    

 

 

 

 

 

 

 

 

 

 

 

 The four fundamental parts of computer are: 

1.Input Devices:   Computer systems use many devices for input purpose. Input devices include the 

mouse, input pen touch screen, microphone. Regardless of the type of device used, all are 

components for interpretation and communication between people and computer systems. 

2. Central Processing Unit (CPU): It is the brain of the computer without this unit computer unable to 

process. 

3. Output device: Output device is used to show the result of the instructions. Example Monitor, 

Printer, Headphones etc. 

4. Memory unit: A memory unit is the collection of storage units or device together. 

The memory unit stores the binary information in the form of bits. 

Q2. Discuss about the classification of computer based on size and capacity. 

Ans. Based on size and capacity, computers are classified as 

1) Super computers: They have thousands of process, Because of their extraordinary speed, 

accuracy and processing power, supercomputers are well suited for solving highly complex 

problems and huge amount of calculations. 

E.g. JAGUAR, ROADRUNNER etc.   

  2)  Mainframe computers: They are very large often filling an entire room and process thousands of 

millions of instructions per second. They are capable of supporting hundreds to thousands of users 

simultaneously. Functions performed by mainframes include flight scheduling, reservations and 

ticketing for an airline etc. 
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3) minicomputers: They are much smaller than mainframes. They are typically larger, more powerful 

and more expensive than desktop computers. Users connect to the server through a network by 

using desktop computers. 

 e.g. apple I pod, CDC 160A. 

4) Microcomputers: They are the most frequently used type of computers. It is also known as 

personal computers. 

e.g. Desktop computer, laptop. 

Q3. What is the meaning of computer generation? How many computer generations are defined? 

What technologies were/are used? 

Ans. Generation in computer terminology is a change in technology of a computer which were being 

used. There are four computer generation such as 1st generation, 2nd generation, 3rd generation and 

4th generation.  

In the first computer generation system, vaccum tubes are used. 

Transistors are used in the Second generation. 

Integrated circuit technology were used in the third generation. 

In the fourth generation microprocessors are used. 

Q3. What is the meaning of computer generation? How many computer generations are defined? 

What technologies were/are used? 

Ans. Generation in computer terminology is a change in technology of a computer which were being 

used. There are four computer generation such as 1st generation, 2nd generation, 3rd generation and 

4th generation.  

In the first computer generation system, vaccum tubes are used. 

Transistors are used in the Second generation. 

Integrated circuit technology were used in the third generation. 

In the fourth generation microprocessors are used.  

Q4. Differentiate between volatile and non-volantile memories. 

Ans.  Volatile memory      Non-Volatile memory   

1. It is a computer storage that      1. It is a type of computer 

            Only maintains its data while          memory that has the capability 

                The device is powered.           to hold saved data even if the power is turned       

2  .  E.g. RAM                                                            off. 

3. Primary memory has limited  2. E.g. ROM, hard disk, floppy disk ,etc 

 storage Capacity and is 

 volatile                 3.Secondary memory provides permanment storage     

                       of data and in bulk quantity. 
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Q5. Distinguish among system software, application software and open software on the basis of 

their features. 

Ans. System software: Its is a type of software that is designed to run a computer’s hardware and 

application programs. Software like operating systems, compilers, editors and drives etc. come 

under this category. A computer cannot function without the presence of system software. 

Q6. a) Create a file in MS-Word to insert a paragraph about yourself and save it with film name 

“yourself”. Describe all step involved in it. 

Ans.  “Yourself”     My name is Asem Jogabanta Singh . I am 20 years old. I love in playing Footballs. I 

am a student of Arts stream at IMPHAL COLLEGE, IMPHAL,MANIPUR. Currently I am learning 

computer CCA course at RGI TRAINING INSTITUTION. 

The steps involved are; 

➢ We click the Microsoft office button. 

➢ We select new. The new documents dialog box appears. 

➢ We select blank document under the blank and recent section. I will be highlighted by 

default. 

➢ We click create. A new blank documents appear in the word window. 

➢  To save the document, We click again the Microsoft office button. 

➢  We select save as            word document. The save as dialog box appears. 

➢ We select the location where we want to save the document using the drop down menu. 

➢ We enter the file “yourself” for the document. 

➢ We click the save button. 

b) Write steps regarding followings. 

➢ To change the font style 

➢ To change the font size 

➢ To change the font colour 

➢ To highlight (in yellow) the line that reads “need to get IMS’s address”. 

Ans. Steps to change the font style: 

1. We select the text we want to modify. 

2. Left click the drop-down arrow next to the font style box on the home tab. The font style 

drop-down menu appears. 

3. We move cursor over the various font styles.  A live preview of the font will appear in the 

document. 

4. Left click the style we want to use. The font style will change in the document. 

Steps to change the font size: 

1. We select the text we want to modify. 

2. Left click the drop-down arrow next to the font size box on the home tab. The font size 

drop-down menu appears. 

3. We move cursor over the various font sizes. A live preview of the font size will appear on 

the document. 

4. 4. Left click the font size we want to use. The font size will change in the document. 

Steps to change the font colour: 
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1. We select the text we want to modify. 

2. Left click the drop-down arrows next to the font colour box on the home tab. The font 

colour menu appears. 

3. We move cursors on various font colours. A live preview of the colour will appear in the 

document. 

4. Left click the font colour we want used. The font colour will change in the document. 

Steps to highlight the line: 

1. We select the line that reads “needs to get IMS’s address” 

2. We click the highlight command and select yellow colour in the font group on the home tab. 

Q7. Create a file in MS- Word for the following document and save it with file name ‘ms-word’. 

Describe all steps involved in it. 

       MS-Word 

       MS-Word is a widely used commercial word processor developed by Microsoft. 

       Ms-Word is application software, Which is capable of 

• Creating, 

• Editing, 

• Saving, 

• Printing any type of document, 

Ans. MS-Word 

         MS – Word is a widely used commercial word processor developed by Microsoft. 

        MS-Word is application software, which is capable of  

• Creating 

• Editing 

• Saving 

• Printing any type of document 

The steps involved are: 

1. We click the Microsoft office button. 

2. We select new. The new document dialog box appears. 

3. We select blank document under the blank and recent section. If will be highlighted by 

default. 

4. We click create. A new blank document appears in the word window. 

5. We create the give documents from the question. 

6. We select the text “MS-Word” to change the font size by clicking on the font size box on 

the home tab. 

7. We select the text “MS-Word” to change the font colour into red by clicking on the font 

colour menu. 

8. We select the text word processor and underline it by clicking underline command in the 

font group the home tab. 

9. We select the text “MS-Word” to change the font style into italic by clicking italic 

command. 
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10. We select the text we want to format as a list and click on the bullets command on the 

home tab. 

11. We change the font colour of the text “creating” and “saving” into blue and red resp. By 

clicking on the font colour command, again we select the text “and” and click on 

strikethrough command. 

12. We select the text “printing any type of document” and change the font style into bold by 

clicking on the font style command. 

13. We save the file name as “ ms-word” by clicking the Microsoft office button and select save 

as  

14. We select the location where we want to save the document using drop-down menu 

15. We click the save button. 

Q8. Create a file in MS-Word for the following document and save it with file name ‘equation’. 

Describe all steps involved in it. 

    Equations: 

X2 +y2=30 

z3+q4=50 

a2+b8=x2+y2 

Ans.  Equations 

X2 + y5 =30 

Z3 + q4 =50 

A2 +b8 =x2 + y8 

The steps are: 

1. We create the given documents in MS-Word 

2. We select the text where we want to format and click on the subscript and superscript 

command on the home tab 

3. We save the file name as “equation” by clicking the Microsoft office button and select save 

as  

4. We select the location where we want to save the document using the drop down menu  

5. We click the save button. 

Q9. Create a file in MS-Word that convert existing highlight text to table as show below and save it 

as file name ‘text to table ‘. Describe all steps involved in it. 

     Select the text you to convert. 

     Select the insert tab. 

     Click on table command. A dialog box appears. 

     Click on convert text to table, a new dialog box appears here set number of columns. 

     Click on OK Finally Selected text convert in a table 
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Select the text convert you want to.  Select the Insert tab. 

Click on table command. A dialog box appears. Click on convert text to table, a new dialog box 
appears. 

Here set columns. Click on OK Finally Selected text convert in atable 
 

 

Ans. To convert existing text to table: 

1. We select the existing highlight text that we want to convert. 

2. We select the insert tab 

3. We click the table command 

4. We select convert text to table form the menu. A dialog box appears 

5. We click ok. Them the text appears in a table. 

Q10. Create a file in MS-Word to insert a table in the document. Describe all steps involved in it. 

Ans. 

          

          

          

          

          

          

          

 

The steps are: 

1. We place our insertion point in the document where we want our table to appear 

2. We select the insert tab 

3. We click the table command  

4. We drag our mouse over the diagram square to select the numbers of columns and rows 

in the table 

5. Left click our mouse and the table appears in the document. 

6. We enter the text into the table. 

Q11. Create a following worksheet in MS-Excel and save it with name ‘book1’. 

            Roll No                       Name                               Marks 

 

  

    

                               

        

 

 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

n1 

n2 

n3 

n4 

n5 

n6 

n7 

n8 

n9 

n10 

 

60 

70 

80 

90 

40 

50 

77 

44 

88 

55 
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Ans.                 Minimum                                              40 

Q12. Calculate the following things of a range (c2:c11) of data in the worksheet created in 

question no 10. 

▪ The sum of the marks using AutoSum in range of cells (c2:c11) 

▪ Average of the marks in range of cells (c2:c11) 

▪ Highest marks in range of cells (c2:c11) 

▪ Minimum marks in a range of cells (c2:c11) 

Roll No. Name Marks 

1 n 1 60 

2 n 2 70 

3 n 3 80 

4 n 4 90 

5 n 5 40 

6 n 6 50 

7 n 7 77 

8 n 8 44 

9 n 9 88 

10 n 10 55 

 Sum 654 

 

 

Ans.                     Minimum           40 

Q13. a) Describe various steps involved in the following  

▪ To modify column width of a worksheet 

▪ To modify the row height of a worksheet 

▪ To delete rows and columns of a worksheet 

Ans.      

I. Select s column or a range of columns. 

II. Select a Home tab and in the cells group, select format. 

III. Click on column width and the width for column. 

IV. Select Ok. 

- To modify the row height of a worksheet. 

I. Select a row or a range of rows. 

II. Select a Home tab and in the cells group, select format. 

III. Click on Row height and Type the height for row. 

IV. Select OK 

654 

65.5  

90 

 

 

Sum 

average 

maximum  

Average 

Maximum 

65.5 

90  
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- To delete rows and columns of a worksheet. 

I. Select the cell you want to delete within the column or row. 

II. Select Home tab. And in cell group click on Delete Sheet Column or Row. 

           OR 

i. Select the desire row or column. 

Q13 b) Describe the following terms in the worksheet   

- Absolute reference and relative reference in formula. 

- Cell address. 

Ans. 

- Absolute Reference: 

An absolute reference in Excel means there is a fixed point of reference applied to a cell or a 

formula. This is so the return value will always stay the same no matter where the cell or 

formula moves to – within the same sheet or across different sheet. 

 

 

This refers to a fixed point of reference is a constant, and involves the use of dollar sign € in 

the formula (i.e, everyone is to receive the same bonus payout, so the amount €1500 is 

constant in this situation). 

  

    

- Relative Reference : 

It is the default cell reference in Excel. It is simply the combination of column name and row 

number without any dollar € sign. When you copy the formula from one cell to another the 

relative cell address changes depending on the relative position of column and row. C1, D2, 

E4, etc. are examples of relative cell references. Relative references are used when we want 

to perform a similar operation on multiple cells and the formula must change according to 

the relative address of column and row. 

This refers to a relative point of reference, is constantly change and dollar sign (€) is absent 

in the formula (i.e., When each unit price and quantity are difference variable, there’s no 

constant in the calculation). 

 

- Cell Address: 

A cell address is a combination of column letter and a row number that identifies a cell on a 

worksheet. 

For example, A1 refers to the cell at the intersection of column A and row 1; B2 refers to the 

second cell in the column B, and so on. 

    When used in formula, cell references help Excel find the values the formula should 

calculate. For instance, 

   .    To pull the value of A1 to another cell, you use this simple formula: 

      =A1 

   .    To add up the value in cells A1 and A2, you use this one: 
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                   =A1+A2 

Q14.a) What tools are available to customize our PowerPoint presention are: 

Ans.  

Tools available to customize our Power Point presentation are: 

a. Perspector 

b. Pivot viewer 

c. Autodesk 3DS Max 

d. VisualBee Power Pointg Add-in 

e. SmartArt 

f. Animiations and Transition 

g. Wordle 

h. CA coo  

i. Oomfo 

j. Clip Champ 

b) Write the steps for the following action for the creation of power point presentation 

 -  Open a Blank presentation 

 -  Save the presentation as Lab1.pptx 

 -   Add a Title to the first slide; the name of your college 

-    Type your first name and last  name in the Subtitle section 

-   Add a New Slide which has a Title and Content 

 Ans.    

- To open blank presentation; 

i. Open PowerPoint presentation using ‘Run’ command ( window key + R) 

ii. Select the ‘Blank Presentation’. It is opened.  

-  Save the presentation on Lab1.pptx; 

I. Select the ‘File’ on tab bar. 

II. Click on ‘Save As’ option. 

III. Click on document/Desktop as your choice. 

IV. Type the name ‘Lsb1.pptx’. 

V. Click the ‘Save’ button. 

- Add a Title to the first slide; the name of your college. 

I. Left click on the ‘Click to add title’ section on the first slide. 

II. Type the name of your college. 

- Type your first name and last name in the subtitle section: 

I. Left click on the ‘Click to add Subtitle’ section. 

II. Type your first name and last name. 

- Add a new slide which has a Title and content. 

I. Select the Home tab. 

II. Click on the dropdown button of the ‘New Slide‘ on toolbar. 

III. Select the side having ‘Title and Content’. It is a added. 
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Q15. Write steps for creation of a set of PowerPoint slide that demonstrates your skill to use the 

tools of PowerPoint. It should include the following things 

➢ Titles slide & bullet list 

➢ Inserting Excel Sheet 

➢ Clip art and text 

➢ Slide show effects 

 

Ans.  

➢ Title slide and bullet list: 

I. Open PowerPoint presentation. 

II. Select the Home tab. 

III. Click at the dropdown button on ‘New Slide’ at toolbar. 

IV. Select the slide having Title slide and Bullet list. 

➢ Inserting Excel sheet: 

I. Open the slide where yiu want to insert the Excel sheet. 

II. Select the ‘insert tab’. And click on ‘Object’ on toolbar. 

III. Select the ‘Microsoft Excel Worksheet’ object type. 

IV. Click the ‘OK’ button. 

➢ Clip Art and text: 

I. Selection the insert tab. 

II. Select the ‘Pictures’ or ‘Online Pictures’ on tool bar. 

III. Choose the appropriate art for the topic. 

IV. Click on the ‘insert’ button. 

➢ Slide show effects: 

I. Select ‘Design Tab’ for themes,Variants and slide size. 

II. Select ‘Transition Tab’ for cut, fade, push, wipe, split, Reveal, shape, Flash, etc. for slide 

effects. 

Q16. What is the difference Machine language and High level Language? 

Ans. 

 

 

  

  

 

 

 

 

 

Q17. Discuss about different data types of C programming Language. 

            Machine language                High level language 

1. A computer programming 

language consisting of 

binary instruction which a 

computer can respond to 

directly. 

2. It require no translator to 

translate the code. It is 

directly understood by the 

computer. 

3. This language makes fast 

and efficient use of the 

computer. 

1. It is a programming language 

that enables development of a 

program much more user 

friendly programming context. 

2. It takes additional translation 

time to translate the source 

code to machine code. 

3. The takes additional 

translation time to translate 

the source code to machine 

code 

4. They are programmer friendly. 
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Ans. The different data types in C programming language are: 

Char: The most basic data type in C. It store a single character and requires a single bite of 

memory in almost all compilers. 

 

Int: As the name suggests, an Int variable is used to store an integer. 

Float: It is used to store decimal numbers, 

Double: It is used to store decimal numbers (number with floating point value but of memory in 

high in comparison to float) 

Q18. Find the output of the following expressions. 

a) X=20/5*2+30-5   b) Y=30-(40/10+6)+10      c) Z=40*2/10-2+10 

       Ans. a) X=33 

b) Y=30 

c) Z=16 

Q19. Describe the syntax of the following statement. 

a) If – else statement  b) For loop  c) White loop  d) Do- while loop 

Ans. a) If – else statement: 

       If statements can be followed by an optional else block of statements, which executes when the 

Boot can expression is false. 

Syntax 

If (expression) 

{ 

True block of statements; 

} 

else 

{ 

else block of statements; 

} 

b) For loop is similar to while loop. Basic syntax of loop is as follows: 

For (expression 1; expression 2; expression 3) 

{ 

Block of statement 

} 

In the above syntx 

Expression 1- initialize variable 
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Expression 2- conditional expression as long as this condition is true, loop will keep 

executing. 

Expression 3- itis the modifier which will increase or decrease the value of the variable. 

c) While loop 

Basic syntax of while loop is as follows 

While (condition) 

        Single statements 

OR while (condition) 

{ 

Block of statements 

} 

d) Do- while loop. 

Do- while loop is just like a while loop except that text condition is checked at the end of the 

loop rather thn the start. This has the effect that the body of the loop are always executed at 

least once 

Basic syntax of do- while loop is as follows. 

Do 

{ 

Single statements 

      OR 

} while ( condition ); 

Q20. Find the output of the following program segments 

 

 

   

 

 

 

 

 

 

 

 

 

Ans. a) 1 

      b)  2 

      C) b=100 

  a)   b)   c) 

#include <stdio.h> 

Int main() 

{ 

  Int I; 

  For (i=1;I<2;I++) 

  { 

   Printf(“IMS Ghaziabad\n”); 

   } 

} 

#include <stdio.h> 

Int main() 

{ 

  Int I=1; 

  While ( 1<=2 ) 

  { 

   Printf(“IMS Ghaziabad\n”); 

   } 

} 

 

#include <stdio.h> 

Vold  main() 

{ 

  Int a=10, b=100; 

  If ( a>b ) 

   Printf(“Largest number is 

%\n”,a); 

  else 

   Printf(“Largest number is 

%d\n”,b); 

   } 
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NO NAME MARKS SUM AVERAGE MIXIMUM MINIMUM

1 n1 60 654 65.4 90 40

2 n2 70 594 66 90 40

3 n3 80 524 65.5 90 40

4 n4 90 444 63.42857 90 40

5 n5 40 354 59 88 40

6 n6 50 314 62.8 88 44

7 n7 77 264 66 88 44

8 n8 44 187 62.33333 88 44

9 n9 88 143 71.5 88 55

10 n10 55 55 55 55 55

Q 11 



SUBJECT TERM1 TERM 2 TERM 3 TERM 4 FINAL

MATH 45 56 60 56 217

ENGLISH 50 83 54 70 257

HISTORY 60 50 50 60 220

GEOGRAPHY 80 70 20 90 260

BIOLOGY 50 60 40 50 200

AVERAGE 57 63.8 44.8 65.2 230.8

HEIGHEST 80 83 60 90 260

LOWEST 45 50 20 50 200

Q12 



Ans. 

Tools available to customize our PowerPoint 
presentation are:

a) Perspector

b) Pivot viewer

c) Autodesk 3DS Max

d) VisualBee PowerPoint Add-in

e) SmartArt

f) Animations and Transition

g) Wordle

h) CA coo

i) Oomfo

j) Clip champ  



b) Write the steps for the following action for the creation of power point 

presentation

▪ Open a Blank presentation

▪ Save the presentation as Lab1.pptx

▪ Add a Title to the first slide: the name of your collage

▪ Type your first name and lat name in the Subtitle section

▪ Add a New Slide which has a Title and Content

Ans.

➢ To open blank presentation

I. Open PowerPoint presentation using ‘Run’ command (Window Key + R)

II. Select the ‘Blank Presentation’. It is opened.

➢ Save the presentation on Lab1.pptx.:

I. Select the ‘File’ on Tab bar.

II. Click on ‘Save As’ option.

III. Click on document/Desktop as your choice.

IV. Type the name ‘Lab 1.pptx’.

V. Click the ‘Save’ button.



➢ Add a Title to the first slide; the name of your college.

I. Left click on the ‘Click to Add Title’ section on the first 

slide.

II. Type the name of your college.

➢ Type your first name and last name in the subtitle 

section;

I. Left click on the ‘Click to Add Subtitle’ section.

II. Type your fist name and last name.

➢ Add a New slide which has a title and content.

I. Selection the home tab.

II. Click on the dropdown button of the ‘New Slide ‘ on toolbar.

III. Selection the slide having ‘title and Content’. It is added.



Q15. Write steps for creation of a set of PowerPoint slides that demonstrates your 

skill to use the tools of PowerPoint. It should include the following things.

-- Titles slide 7 bullet list

-- inserting Excel Sheet

-- Clip art an text

-- slide show effects

Ans.

 Title slide and bullet list:

➢ Open PowerPoint Presentation.

➢ Select the home tab.

➢ Click at the dropdown button on ‘New Slide’ at toolbar.

➢ Select the slide having title slide and bullet list.

 Inserting Excel sheet;    

➢ Open the slide where you want to insert the excel sheet.

➢ Select the ‘insert tab’. And click on ‘Object’ on tool bar.

➢ Select the ‘Microsoft Excel worksheet’ object type.

➢ Click the ‘OK’ button. 



• Clip Art and Text;

I. Select the insert Tab.

II. Select the ‘Pictures’ or ‘Online pictures’ on tool bar.

III. Choose the appropriate art for the topic.

IV. Click on the ‘insert’ button,

 Slide show effects;

I. ‘Select ‘Design Tab’ for themes, Variants and Slide size.

II. Select ‘transition tab’ for Cut, push, Wipe, Split, Reveal, 

Shape, Flash, etc. for slide effects. 


